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Copyright Notices
Copyright©2017 – Expert4x, all rights reserved. This eBook is intended for the
purchaser’s personal use only. No part of this eBook may be reproduced or transmitted in
any form whatsoever, electronic, or mechanical, including photocopying, recording, or by
any informational storage or retrieval system without expressed written permission from
Expert4x.
Copyright©2017 EAfactory, all rights reserved. All title, including but not limited to
copyrights, in and to the NoWorries EA and any copies thereof are owned by EAfactory
or its suppliers. All title and intellectual property rights in and to the content which may
be accessed through use of the NoWorries EA is the property of the respective content
owner and may be protected by applicable copyright or other intellectual property laws
and treaties. All rights not expressly granted are reserved by EAfactory. For the full details
please refer to the End-User License Agreement ("EULA")
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Getting Started with the NoWorries EA
Getting Started provides a guided exploration of the NoWorries EA. It is geared for an
audience that has little or no knowledge of installing MT4 EA. It walks the novice user
through downloading and installing the NoWorries EA.

2.1 Installing the NoWorries EA
The NoWorries EA comes with a setup application to provide a wizard based installation
process to the selected MT4 terminal.

Before you start...
• Ensure that you have the login credentials to the Web Support Centre.
• Ensure that you have an MT4 terminal version 4.00 build 1090 or later installed.
1. Exit MT4 if it was running.
2. Log in to the Web Support Centre.

3. Select the desired service and download the setup application with the latest version.
4. Run the setup application. Select the MT4 instance during setup to where you want
the service installed.
5. When setup completes start up MT4. NoWorries EA entry should appear under the EA
node in the Navigator window (View > Navigator)
These pictures highlight the steps how to install the EA.
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The setup application lists the available MT4 instances. Select one of them for installation
target and click Next.
Note:
For some earlier version Windows version the list may not contain all the MT4 instances.
In this case use the Add target directory... button to navigate and pick up the desired
folder.
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For earlier Windows versions the typical MetaTrader installation location could be
C:\Program Files\BrokerSpecificName\
but you may have selected something else while performing the MetaTrader installation.
As a hint, the following shows you the default path to the main MT4 directory for some
brokers:
Broker
IBFX broker

Default Path
C:\Program Files\Interbank FX Trader

Tallinex broker

C:\Program Files\Tallinex MetaTrader 4

ODL UK broker

C:\Program Files\ODL MetaTrader 4

Always select the main MT4 folder itself for installation target, not any of its subdirectories.

When the installation is complete, start up MT4 and check that the EA appears in the
Navigator window (View > Navigator):
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So everything is set up for the first activation of the NoWorries Expert Advisor .

2.2 NoWorries Expert Advisor First Time Activation
Step by step guide to get the EA up and running on a chart for the first time.
The following pictures demonstrate the first time activation of the NoWorries Expert
Advisor in a few steps.

Attach the EA to a chart
1. Drag & drop the NoWorries Expert Advisor from the Navigator window (View >
Navigator) to a chart window and select the Common tab:
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Note: Ensure that the
• Allow live trading,
• Allow DLL import and
• Allow import of external experts
are checked.
2. Select the Inputs tab:
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This lists the parameters of the EA where the operational aspect of the NoWorries EA
can be set up. For more details see the NoWorries EA Configuration Guide – for now
click OK and let the EA start up with default settings.
Note:
At the very first time the EA may prompt for the Access ID to verify that the usage of
product is licensed.
The Access ID is pre-configured and is the same as the login name to the web
support site. Feel free to change your Access ID at the Web Support Centre and
ensure not to share it with anyone else. Enter the Access ID and click Save:

The NoWorries EA is up and running
After successful authentication the NoWorries EA starts up.
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The NoWorries Expert Advisor has been attached to the chart. The smiley face in the topright corner shows that the initialisation of the NoWorries Expert Advisor was successful
and the EA is now looking for trading opportunities.
See the smiley face in the corner:

In case of a problem getting the EA up and running please refer to the Knowledgebase
section.
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System Requirements
Overview of prerequisites in order to install and get the product up and running.

3.1 Operating System Requirements
In order to operate the NoWorries EA a Microsoft Windows operating system is required
which supports MetaQuotes MetaTrader version 4.0 platform.
Note that the MetaQuotes MetaTrader software is also known and often referred to as
MT4.

3.2 Hardware Requirements
The minimum Random Access Memory (RAM) requirement is 384MB, however 512MB
RAM is recommended to avoid extended virtual memory usage. Note that this memory
requirement is for MetaTrader application only, excluding other applications running at
the same time (e.g. MS Office). If other applications are running parallel with MetaTrader
application please increase the RAM requirement accordingly.

3.3 MetaTrader (MT4) Requirements and Settings
The EA is compatible with MetaQuotes MetaTrader platform version 4.00 build 1090 or
higher. In general this is referred to as MT4 terminal, build 1090 or newer.

3.4 Forex Broker Requirements
The NoWorries EA is compatible with both 4 and 5-digit data feeds based brokers. The
NoWorries EA automatically detects the type of the feed and adjusts the EA parameter pip
values if and when necessary.
Both fixed and variable spread broker platforms are supported.
The selected MetaTrader based broker should allow keeping open orders on the account
for long period of time, i.e. the broker should not close and re-open orders over night for
swap calculation, or should not merge open orders for any reason.
IMPORTANT: For smooth trade management the MetaTrader application and the EA
should be on-line, up and running during all market open hours (usually Sunday to
Friday).

3.5 Hedging Support Requirements
The EA may open BUY as well as SELL positions at the same time on the same market.
Because of this the broker account must support the hedging of trades.
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3.6 Non-FIFO Support Requirements
The NoWorries EA may open and close positions out of order of the first-in-first-out (FIFO)
sequence. Therefore the broker account must support the order handling in non-FIFO
manner.
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NoWorries EA Configuration Guide
The NoWorries EA configuration guide.
In order to activate the NoWorries EA attach it to a chart window – for more details see
NoWorries EA First Time Activation section.

4.1 Configuration and Operation Principles
The NoWorries EA operational overview.
The NoWorries EA enters and removes hedge protection trades for other existing open
positions found on the broker account. Those existing open positions may have been
created manually, or by other EAs. The existing open positions can have any Magic
Number value, however the NoWorries EA must be configured with a unique MagicNumber
to distinguish the created hedge positions from all the other existing positions.
The EA only deals with open positions of the chart it is attached to. If the EA is attached
to a chart of the EURUSD market then the EA applies hedge protection to all open
positions on the EURUSD pair. Open positions on other markets, e.g. GBPUSD, USDJPY
etc, will be ignored as those market names do not match with the EURUSD, the chart of
the EA. The very same applies to the close all trade feature of the EA. Only those open
trades will get closed by the close all feature where the market of the open position is
the same as the market of the chart the EA is attached to. An EA attached to the GBPJPY
chart will only consider to close open GBPJPY trades when the 'Close All Trade' feature of
the EA is used.
Refer to the sample use cases as how the various scenarios can be operated using the EA:
1.Weekend Hedge Protection For Open Trades on page 27
2.News Time Hedge Protection For Open Trades on page 28
3.Price Range Hedge Protection For Open Trades on page 30
4.End Of Day Close ALL Open Trades on page 31
5.News Time Close ALL Open Trades on page 32
6.Price Level Close ALL Open Trades on page 33
Once the EA entered a hedge protection trade it will monitor the open trade which is being
protected by the hedge. Should the monitored open trade get closed, e.g. manually, by
another EA or by SL/TP, the NoWorries EA will automatically close out the corresponding
hedge trade as soon as possible.
If you plan to use the EA for multiple markets at the same time then create a new chart
for each of those markets and attach the EA to each of them. Because of the different
charts, there is no need to change the MagicNumber of the EA, i.e. the same value could
be used.
IMPORTANT: Ensure that the MagicNumber for the NoWorries EA is not in use by any
other EA running on the broker account. Otherwise a clash could occur between the
various EA applications, potentially resulting in EA malfuntions and risk of damage to the
balance of the broker account.
Ensure that for any one market only one EA is active, i.e. there should only be one
EURUSD chart with the EA attached to it.
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4.2 NoWorries EA Parameter Descriptions
The NoWorries EA parameter descriptions.

4.2.1 Trading Logic Settings

Method

Entry

Hedge

Hedge Entry Settings

Hedge Entry Method
Selects the schedule or target entry price level for new hedge protection trades.
When the selected method kicks off the entry of the new hedge trades, the EA creates for
each open position a corresponding hedge trade in the opposite direction, with the same
lot size. Open positions, which already have their corresponding hedge trades, are ignored
to avoid multiple hedge trades for the same open position.

Hedge Entry Method

Description

No New Hedge Entry

Turns off entering new hedge protection trades. Existing
hedge trades, if any open, are not impacted. Those will
get closed according to the Hedge Closeout Settings.
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Hedge Entry Method

Description

Before Market Close On The
Day Selected

Activates entering of hedge protection trades when all the
following conditions are met:
• Day of week matches the selected Day For Hedge
Entry.
• Broker time is the number of minutes before the
close of the market, as configured at the Minutes For
Before Market Close.
Note: The entering of new hedge trades kicks off at the
configured minutes before market close, and limited to the
duration of the activation window. The minutes duration of
the activation window is configured at the Hedge Entry &
Closeout Active Window.

At A Time On The Day
Selected

Activates entering of hedge protection trades when all the
following conditions are met:
• Day of week matches the selected Day For Hedge
Entry.
• Broker time matches the configured time at the Time
For On The Day Selected.
Note: The entering of new hedge trades kicks off at the
configured broker time, and limited to the duration of the
activation window. The minutes duration of the activation
window is configured at the Hedge Entry & Closeout Active
Window.

On Or Beyond The Price
Provided

Activates entering of hedge protection trades when the
current market price reaches, or is beyond the target price
configured at Price For On Or Beyond Price Provided.

The EA only deals with open positions of the chart it is attached to. If the EA is attached
to a chart of the EURUSD market then the EA applies hedge protection to all open
positions on the EURUSD pair. Open positions on other markets, e.g. GBPUSD, USDJPY
etc, will be ignored as those market names do not match with the EURUSD.
Once the EA entered a hedge protection trade it will monitor the open trade which is being
protected by the hedge. Should the monitored open trade get closed off, e.g. manually, by
another EA or by SL/TP, the NoWorries EA will automatically close out the corresponding
hedge trade as soon as possible.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Weekend Hedge Protection For Open Trades on page 27
2.News Time Hedge Protection For Open Trades on page 28
3.Price Range Hedge Protection For Open Trades on page 30

Entry

Hedge

For

Day

Related reference
Day For Hedge Entry on page 16
Minutes For Before Market Close on page 17
Time For On The Day Selected on page 17
Price For On Or Beyond Price Provided on page 18
Hedge Closeout Settings on page 18
Close ALL Settings on page 21
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Day For Hedge Entry
Selects the day of the week when the entry of new hedge protection trades should be
performed.

Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Weekend Hedge Protection For Open Trades on page 27
2.News Time Hedge Protection For Open Trades on page 28

Close

Market

Before

For

Minutes

Related reference
Hedge Entry Method on page 15
Minutes For Before Market Close on page 17
Time For On The Day Selected on page 17
Price For On Or Beyond Price Provided on page 18
Hedge Closeout Settings on page 18
Close ALL Settings on page 21
Hedge Entry & Closeout Active Window on page 26

Minutes For Before Market Close
Determines the number of minutes before the close of market, on the selected day of the
week, when the entry of new hedge protection trades should be performed. In order to
turn on this feature the following input fields should also be set:
• Select Before Market Close On The Day Selected for the Hedge Entry Method.
• Select the desired day at the Day For Hedge Entry.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Weekend Hedge Protection For Open Trades on page 27
2.News Time Hedge Protection For Open Trades on page 28

Selected

Day

The

On

For

Time

Related reference
Hedge Entry Method on page 15
Day For Hedge Entry on page 16
Time For On The Day Selected on page 17
Price For On Or Beyond Price Provided on page 18
Hedge Closeout Settings on page 18
Close ALL Settings on page 21

Time For On The Day Selected
Determines the broker time, on the selected day of the week, when the entry of new
hedge protection trades should be performed. In order to turn on this feature the
following input fields should also be set:
• Select At A Time On The Day Selected for the Hedge Entry Method.
• Select the desired day at the Day For Hedge Entry.
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Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Weekend Hedge Protection For Open Trades on page 27
2.News Time Hedge Protection For Open Trades on page 28

Provided

Price

Beyond

Or

On

For

Price

Related reference
Hedge Entry Method on page 15
Day For Hedge Entry on page 16
Minutes For Before Market Close on page 17
Price For On Or Beyond Price Provided on page 18
Hedge Closeout Settings on page 18
Close ALL Settings on page 21

Price For On Or Beyond Price Provided
Determines the target market price level, at or beyond which, the entry of new hedge
protection trades should be performed. In order to turn on this feature select On Or
Beyond The Price Provided for the Hedge Entry Method.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Price Range Hedge Protection For Open Trades on page 30
Related reference
Hedge Entry Method on page 15
Day For Hedge Entry on page 16
Minutes For Before Market Close on page 17
Time For On The Day Selected on page 17
Hedge Closeout Settings on page 18
Close ALL Settings on page 21

Method

Closeout

Hedge

Hedge Closeout Settings

Hedge Closeout Method
Selects the schedule or target price level for the closeout of the hedge protection trades.
When the selected method kicks off the closeout of the open hedge trades, the EA closes
out each open hedge trades which were created by the EA itself earlier. Other open nonhedge trades, which were not created by the EA, do not get closed off by this feature.
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Hedge Closeout Method

Description

Manual Close Of Hedge
Trade

Turns off closeout of existing hedge protection trades.
Open hedge trades, if any, are not impacted by the EA. It
is the responsibility of the user to close them off manually.

After Market Open On The
Day Selected

Activates closeout of existing hedge protection trades
when all the following conditions are met:
• Day of week matches the selected Day For Hedge
Closeout.
• Broker time is the number of minutes after the open
of the market, as configured at the Minutes For After
Market Open.
Note: The closure of existing hedge trades kicks off at
the configured minutes after market open, and limited
to the duration of the activation window. The minutes
duration of the activation window is configured at the
Hedge Entry & Closeout Active Window.

At A Time On The Day
Selected

Activates closeout of existing hedge protection trades
when all the following conditions are met:
• Day of week matches the selected Day For Hedge
Closeout.
• Broker time matches the configured time at the Time
For On The Day Selected.
Note: The closure of existing hedge trades kicks off at
the configured minutes after market open, and limited
to the duration of the activation window. The minutes
duration of the activation window is configured at the
Hedge Entry & Closeout Active Window.

On Or Beyond The Price
Provided

Activates closeout of existing hedge protection trades
when the current market price reaches, or is beyond the
target price configured at Price For On Or Beyond Price
Provided.

The EA only deals with open positions of the chart it is attached to. If the EA is attached
to a chart of the EURUSD market then the EA applies hedge protection to all open
positions on the EURUSD pair. Open positions on other markets, e.g. GBPUSD, USDJPY
etc, will be ignored as those market names do not match with the EURUSD.
Once the EA entered a hedge protection trade it will monitor the open trade which is being
protected by the hedge. Should the monitored open trade get closed off, e.g. manually, by
another EA or by SL/TP, the NoWorries EA will automatically close out the corresponding
hedge trade as soon as possible.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Weekend Hedge Protection For Open Trades on page 27
2.News Time Hedge Protection For Open Trades on page 28
3.Price Range Hedge Protection For Open Trades on page 30
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Close

Hedge

For

Day

Related reference
Day For Hedge Close on page 20
Minutes For After Market Open on page 20
Time For On The Day Selected on page 20
Price For On Or Beyond Price Provided on page 21
Hedge Entry Settings on page 15
Close ALL Settings on page 21
Hedge Entry & Closeout Active Window on page 26

Day For Hedge Close
Selects the day of the week when the closeout of existing hedge protection trades should
be performed.

Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Weekend Hedge Protection For Open Trades on page 27
2.News Time Hedge Protection For Open Trades on page 28

Open

Market

After

For

Minutes

Related reference
Hedge Closeout Method on page 18
Minutes For After Market Open on page 20
Time For On The Day Selected on page 20
Price For On Or Beyond Price Provided on page 21
Hedge Entry Settings on page 15
Close ALL Settings on page 21

Minutes For After Market Open
Determines the number of minutes after the open of market, on the selected day of the
week, when the closeout of existing hedge protection trades should be performed. In
order to turn on this feature the following input fields should also be set:
• Select After Market Open On The Day Selected for the Hedge Closeout Method.
• Select the desired day at the Day For Hedge Close.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Weekend Hedge Protection For Open Trades on page 27
2.News Time Hedge Protection For Open Trades on page 28

Selected

Day

The

On

For

Time

Related reference
Hedge Closeout Method on page 18
Day For Hedge Close on page 20
Time For On The Day Selected on page 20
Price For On Or Beyond Price Provided on page 21
Hedge Entry Settings on page 15
Close ALL Settings on page 21
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Time For On The Day Selected
Determines the broker time, on the selected day of the week, when the closeout of
existing hedge protection trades should be performed. In order to turn on this feature the
following input fields should also be set:
• Select At A Time On The Day Selected for the Hedge Closeout Method.
• Select the desired day at the Day For Hedge Close.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Weekend Hedge Protection For Open Trades on page 27
2.News Time Hedge Protection For Open Trades on page 28

Provided

Price

Beyond

Or

On

For

Price

Related reference
Hedge Closeout Method on page 18
Day For Hedge Close on page 20
Minutes For After Market Open on page 20
Price For On Or Beyond Price Provided on page 21
Hedge Entry Settings on page 15
Close ALL Settings on page 21

Price For On Or Beyond Price Provided
Determines the target market price level, at or beyond which, the closeout of existing
hedge protection trades should be performed. In order to turn on this feature select On Or
Beyond The Price Provided for the Hedge Closeout Method.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Price Range Hedge Protection For Open Trades on page 30
Related reference
Hedge Closeout Method on page 18
Day For Hedge Close on page 20
Minutes For After Market Open on page 20
Time For On The Day Selected on page 20
Hedge Entry Settings on page 15
Close ALL Settings on page 21

Method

Trade

ALL

Close

Close ALL Settings
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Close ALL Trade Method
Selects the schedule or target price level for the close of all the open trades.
IMPORTANT: This close all feature, when activated, will close off ALL open trades on the
market of the chart, including both hedge and non-hedge trades, regardless of created by
the EA or not.

Close ALL Trade Method

Description

Turned Off

Turns off closeout of all trades. No open trades, if any, are
not impacted by the EA.

Before Market Close On The
Day Selected

Activates entering of hedge protection trades when all the
following conditions are met:
• Day of week matches the selected Day For Close ALL
Trade.
• Broker time is the number of minutes before the
close of the market, as configured at the Minutes For
Before Market Close.
Note: The entering of new hedge trades kicks off at the
configured minutes before market close, and limited to the
duration of the activation window. The minutes duration of
the activation window is configured at the Hedge Entry &
Closeout Active Window.

After Market Open On The
Day Selected

Activates closeout of ALL trades when all the following
conditions are met:
• Day of week matches the selected Day For Close ALL
Trade.
• Broker time is the number of minutes after the open
of the market, as configured at the Minutes For After
Market Open.
Note: The closure of ALL trades kicks off at the
configured minutes after market open, and limited to the
duration of the activation window. The minutes duration of
the activation window is configured at the Hedge Entry &
Closeout Active Window.

At A Time On The Day
Selected

Activates closeout of ALL trades when all the following
conditions are met:
• Day of week matches the selected Day For Close ALL
Trade.
• Broker time matches the configured time at the Time
For On The Day Selected.
Note: The closure of ALL trades kicks off at the
configured minutes after market open, and limited to the
duration of the activation window. The minutes duration of
the activation window is configured at the Hedge Entry &
Closeout Active Window.
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Close ALL Trade Method

Description

On Or Beyond The Price
Provided

Activates closeout of ALL trades when the current market
price reaches, or is beyond the target price configured at
Price For On Or Beyond Price Provided.

Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.End Of Day Close ALL Open Trades on page 31
2.News Time Close ALL Open Trades on page 32
3.Price Level Close ALL Open Trades on page 33

Trade

ALL

Close

for

Day

Related reference
Day for Close ALL Trade on page 23
Minutes For Before Market Close on page 23
Minutes For After Market Open on page 24
Time For On The Day Selected on page 24
Price For On Or Beyond Price Provided on page 25
Hedge Entry Settings on page 15
Hedge Closeout Settings on page 18
Hedge Entry & Closeout Active Window on page 26

Day for Close ALL Trade
Selects the day of the week when the close of all open trades should be performed.
IMPORTANT: This close all feature, when activated, will close off ALL open trades on the
market of the chart, including both hedge and non-hedge trades, regardless of created by
the EA or not.

Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.End Of Day Close ALL Open Trades on page 31
2.News Time Close ALL Open Trades on page 32

Close

Market

Before

For

Minutes

Related reference
Close ALL Trade Method on page 21
Minutes For Before Market Close on page 23
Minutes For After Market Open on page 24
Time For On The Day Selected on page 24
Price For On Or Beyond Price Provided on page 25
Hedge Entry Settings on page 15
Hedge Closeout Settings on page 18

23

Minutes For Before Market Close
Determines the number of minutes before the close of market, on the selected day of the
week, when the close of all open trades should be performed. In order to turn on this
feature the following input fields should also be set:
• Select Before Market Close On The Day Selected for the Close ALL Trade Method.
• Select the desired day at the Day For Close ALL Trade.
IMPORTANT: This close all feature, when activated, will close off ALL open trades on the
market of the chart, including both hedge and non-hedge trades, regardless of created by
the EA or not.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.End Of Day Close ALL Open Trades on page 31
2.News Time Close ALL Open Trades on page 32

Open

Market

After

For

Minutes

Related reference
Close ALL Trade Method on page 21
Day for Close ALL Trade on page 23
Minutes For After Market Open on page 24
Time For On The Day Selected on page 24
Price For On Or Beyond Price Provided on page 25
Hedge Entry Settings on page 15
Hedge Closeout Settings on page 18

Minutes For After Market Open
Determines the number of minutes after the open of market, on the selected day of the
week, when the close of all open trades should be performed. In order to turn on this
feature the following input fields should also be set:
• Select After Market Open On The Day Selected for the Close ALL Trade Method.
• Select the desired day at the Day For Close ALL Trade.
IMPORTANT: This close all feature, when activated, will close off ALL open trades on the
market of the chart, including both hedge and non-hedge trades, regardless of created by
the EA or not.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.End Of Day Close ALL Open Trades on page 31
2.News Time Close ALL Open Trades on page 32

Selected

Day

The

On

For

Time

Related reference
Close ALL Trade Method on page 21
Day for Close ALL Trade on page 23
Minutes For Before Market Close on page 23
Time For On The Day Selected on page 24
Price For On Or Beyond Price Provided on page 25
Hedge Entry Settings on page 15
Hedge Closeout Settings on page 18

Time For On The Day Selected
Determines the broker time, on the selected day of the week, when the close of all open
trades should be performed. In order to turn on this feature the following input fields
should also be set:
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• Select At A Time On The Day Selected for the Close ALL Trade Method.
• Select the desired day at the Day For Close ALL Trade.
IMPORTANT: This close all feature, when activated, will close off ALL open trades on the
market of the chart, including both hedge and non-hedge trades, regardless of created by
the EA or not.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.End Of Day Close ALL Open Trades on page 31
2.News Time Close ALL Open Trades on page 32

Provided

Price

Beyond

Or

On

For

Price

Related reference
Close ALL Trade Method on page 21
Day for Close ALL Trade on page 23
Minutes For Before Market Close on page 23
Minutes For After Market Open on page 24
Price For On Or Beyond Price Provided on page 25
Hedge Entry Settings on page 15
Hedge Closeout Settings on page 18

Price For On Or Beyond Price Provided
Determines the target market price level, at or beyond which, the close of all open trades
should be performed. In order to turn on this feature select On Or Beyond The Price
Provided for the Close ALL Trade Method.
IMPORTANT: This close all feature, when activated, will close off ALL open trades on the
market of the chart, including both hedge and non-hedge trades, regardless of created by
the EA or not.
Refer to the sample use cases as how this input field, in conjuntion with others, is
involved in the various scenarios:
1.Price Level Close ALL Open Trades on page 33
Related reference
Close ALL Trade Method on page 21
Day for Close ALL Trade on page 23
Minutes For Before Market Close on page 23
Minutes For After Market Open on page 24
Time For On The Day Selected on page 24
Hedge Entry Settings on page 15
Hedge Closeout Settings on page 18

4.2.2 Operations Settings
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Hedge Entry & Closeout Active Window
Hedge Entry & Closeout Active Window
Controls the duration of the EA trading activity window. The EA trading activity can be
entering hedge protection trades, closing out those hedge protection trades, or closing
off ALL open trades. These activities kick off according to their configured time based
schedule, like before or after market close or open, or at a configured broker time. This
Hedge Entry & Closeout Active Window parameter limits the activity duration to this
configured number of minutes.
Note: This parameter does not have any effect when the EA activity is kicked off due to
reaching the configured target price level, i.e. when any of the On Or Beyond The Price
Provided method is used.
Note: The EA respects the selected day of the week for the trading activity. If the
scheduled time plus the duration of the Active Window would run into the next day then
the EA will stop the activity once the selected day is over.

Magic Number Parameter
Magic Number
The EA marks its orders with this value when submitting to the broker account, and picks
up orders which are marked with this magic number value and belong to the chart of the
EA. In the case of multiple EA's running on the same market ensure that they get unique
Magic Number allocations to avoid cross-impact between the EA instances handling the
orders. See Configuration and Operation Principles section for more explanation and setup
examples.
Related information
Configuration and Operation Principles

Chapter

5

Knowledgebase
Frequently Asked Questions and other common use cases.

5.1 Weekend Hedge Protection For Open Trades
How To Guide
I have open trades on the broker account and the weekend is coming. I want the EA to
place hedge trades 30 minutes before the weekend and close off those hedge trades after
the weekend.

Weekend Hedge For a Single Market
Let's assume that there are open trades on the EURUSD market. The EURUSD market
closes off Friday night and reopens Sunday night or Monday in the morning.
1. Create a new chart of the market in the MT4 terminal, e.g. a chart of the EURUSD.
The timeframe of the chart can be anything, it does not have any impact to the
hedge or close all features of the EA.
2. Attach the EA to this new chart and select the Inputs tab of the EA properties
window.

3. Double click the value of the Hedge Entry Method and select the Before Market Close
On The Selected Day item.

4. Double click the value of the Day For Hedge Entry and select Friday.
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5. Double click the value of the Minutes For Before Market Close and type in 30.
6. Double click the value of the Hedge Closeout Method and select the After Market
Open On The Selected Day item.

7. Double click the value of the Day For Hedge Close and select Monday.

8. Double click the value of the Minutes For After Market Close and type in 30.
9. Finally click the OK button of the EA properties window to let the EA start up on the
chart.
The EA starts up and becomes ready to place the hedge protection trades for each
of the open trades 30 minutes before market close on Friday, then to close off the
hedge trades 30 minutes after market open on Monday.

Weekend Hedge For Multiple Markets
There could be open trades for more than one market on the broker account, e.g.
EURUSD as well as USDJPY market. In order to manage hedge trades for multiple markets
a separate chart with the EA attached is required for each.
1. Prepare a list of the markets with any open trades you want to protect with hedge
trades.
2. For each market on the list, follow the above process Weekend Hedge For a Single
Market to create a chart and attach the EA.

5.2 News Time Hedge Protection For Open Trades
How To Guide
I have open trades on the broker account and a news announcement is coming on
Tuesday, with a potenial to spike the markets. I want the EA to place hedge trades before
the news and close off those hedge trades after the news on Tuesday.

News Time Hedge For A Single Market
Let's assume that there are open trades on the EURUSD market. The news announcement
is scheduled for 9am on Tuesday, so configure the EA to place hedge trades at 8:50 and
close off those hedge trades at 9:30 on Tuesday.
1. Create a new chart of the market in the MT4 terminal, e.g. a chart of the EURUSD.
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The timeframe of the chart can be anything, it does not have any impact to the
hedge or close all features of the EA.
2. Attach the EA to this new chart and select the Inputs tab of the EA properties
window.

3. Double click the value of the Hedge Entry Method and select the At A Time On The
Selected Day item.

4. Double click the value of the Day For Hedge Entry and select Tuesday.

5. Double click the value of the Time For On The Day Selected and type in 8:50.
6. Double click the value of the Hedge Closeout Method and select the At A Time On The
Selected Day item.

7. Double click the value of the Day For Hedge Close and select Tuesday.

8. Double click the value of the Time For On The Day Selected and type in 9:30.
9. Finally click the OK button of the EA properties window to let the EA start up on the
chart.
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The EA starts up and becomes ready to place the hedge protection trades for each
of the open trades at 8:50 on Tuesday, then to close off the hedge trades at 9:30 on
Tuesday.

News Time Hedge For Multiple Markets
There could be open trades for more than one market on the broker account, e.g.
EURUSD as well as USDJPY market. In order to manage hedge trades for multiple markets
a separate chart with the EA attached is required for each.
1. Prepare a list of the markets with any open trades you want to protect with hedge
trades.
2. For each market on the list, follow the above process News Time Hedge For A Single
Market to create a chart and attach the EA.

5.3 Price Range Hedge Protection For Open Trades
How To Guide
I have open trades on the broker account and the price may swing beyond a level before
it reverts back. I want the EA to place hedge trades if the price goes beyond a certain
level and close off those hedge trades when price reverts back to another level.

Price Range Hedge For A Single Market
Let's assume that there are open trades on the EURUSD market and the current bid price
is 1.1750. I want the EA to place hedge trades should the price go to or beyond 1.1850
and remove those hedge trades when the price reverts back to 1.1800.
1. Create a new chart of the market in the MT4 terminal, e.g. a chart of the EURUSD.
The timeframe of the chart can be anything, it does not have any impact to the
hedge or close all features of the EA.
2. Attach the EA to this new chart and select the Inputs tab of the EA properties
window.

3. Double click the value of the Hedge Entry Method and select the On Or Beyond The
Price Provided item.

4. Double click the value of the Price For On Or Beyond Provided and type in 1.1850.
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5. Double click the value of the Hedge Closeout Method and select the On Or Beyond
The Price Provided item.

6. Double click the value of the Price For On Or Beyond Provided and type in 1.1800.
7. Finally click the OK button of the EA properties window to let the EA start up on the
chart.
The EA starts up and becomes ready to place the hedge protection trades for each of
the open trades should the price go to or beyond 1.1850, then to close off the hedge
trades when price reverts back to 1.1800.

Price Range Hedge For Multiple Markets
There could be open trades for more than one market on the broker account, e.g.
EURUSD as well as USDJPY market. In order to manage hedge trades for multiple markets
a separate chart with the EA attached is required for each.
1. Prepare a list of the markets with any open trades you want to protect with hedge
trades.
2. For each market on the list, follow the above process Price Range Hedge For A Single
Market to create a chart and attach the EA.

5.4 End Of Day Close ALL Open Trades
How To Guide
I have open trades on the broker account and the weekend is coming. I want the EA to
close all my open trades 30 minutes before the weekend.

End Of Day Close All Trades For a Single Market
Let's assume that there are open trades on the EURUSD market. The EURUSD market
closes off Friday night.
1. Create a new chart of the market in the MT4 terminal, e.g. a chart of the EURUSD.
The timeframe of the chart can be anything, it does not have any impact to the close
all feature of the EA.
2. Attach the EA to this new chart and select the Inputs tab of the EA properties
window.
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3. Double click the value of the Close ALL Trade Method and select the Before Market
Close On The Selected Day item.

4. Double click the value of the Day For Close ALL Trade and select Friday.

5. Double click the value of the Minutes For Before Market Close and type in 30.
6. Finally click the OK button of the EA properties window to let the EA start up on the
chart.
The EA starts up and becomes ready to close all open trades 30 minutes before
market close on Friday.

End Of Day Close All Trades For Multiple Markets
There could be open trades for more than one market on the broker account, e.g.
EURUSD as well as USDJPY market. In order to close all open trades for multiple markets
a separate chart with the EA attached is required for each.
1. Prepare a list of the markets with any open trades you want to get all closed.
2. For each market on the list, follow the above process End Of Day Close All Trades For
a Single Market to create a chart and attach the EA.

5.5 News Time Close ALL Open Trades
How To Guide
I have open trades on the broker account and a news announcement is coming on
Tuesday, with a potenial to spike the markets. I want the EA to close all open trades
before the news on Tuesday.

News Time Close All Trades For a Single Market
Let's assume that there are open trades on the EURUSD market. The news announcement
is scheduled for 9am on Tuesday, so configure the EA to close all open trades at 8:50.
1. Create a new chart of the market in the MT4 terminal, e.g. a chart of the EURUSD.
The timeframe of the chart can be anything, it does not have any impact to the close
all feature of the EA.
2. Attach the EA to this new chart and select the Inputs tab of the EA properties
window.
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3. Double click the value of the Close ALL Trade Method and select the At A Time On
The Selected Day item.

4. Double click the value of the Day For Close ALL Trade and select Tuesday.

5. Double click the value of the Time For On The Day Selected and type in 8:50.
6. Finally click the OK button of the EA properties window to let the EA start up on the
chart.
The EA starts up and becomes ready to close all open trades at 8:50 on Tuesday.

News Time Close All Trades For Multiple Markets
There could be open trades for more than one market on the broker account, e.g.
EURUSD as well as USDJPY market. In order to close all open trades for multiple markets
a separate chart with the EA attached is required for each.
1. Prepare a list of the markets with any open trades you want to get all closed.
2. For each market on the list, follow the above process News Time Close All Trades For
a Single Market to create a chart and attach the EA.

5.6 Price Level Close ALL Open Trades
How To Guide
I have open trades on the broker account and I want the EA to close all open trades if a
certain market price level is reached at any point in time.

Price Level Close All Trades For a Single Market
Let's assume that there are open trades on the EURUSD market and the current bid price
is 1.1750. I want the EA to close all open trades should the price go to or beyond 1.1800.
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1. Create a new chart of the market in the MT4 terminal, e.g. a chart of the EURUSD.
The timeframe of the chart can be anything, it does not have any impact to the close
all feature of the EA.
2. Attach the EA to this new chart and select the Inputs tab of the EA properties
window.

3. Double click the value of the Close ALL Trade Method and select the On Or Beyond
The Price Provided item.

4. Double click the value of the Price For On Or Beyond Price Provided and type in
1.1800.
5. Finally click the OK button of the EA properties window to let the EA start up on the
chart.
The EA starts up and becomes ready to close all open trades whenever the market
price reaches or is beyond 1.1800.

Price Level Close All Trades For Multiple Markets
There could be open trades for more than one market on the broker account, e.g.
EURUSD as well as USDJPY market. In order to close all open trades for multiple markets
a separate chart with the EA attached is required for each.
1. Prepare a list of the markets with any open trades you want to get all closed.
2. For each market on the list, follow the above process Price Level Close All Trades For
a Single Market to create a chart and attach the EA.

5.7 Sad Face Instead of Smiley Face After Attach
Issue
After attaching to chart the EA is not managing trades, a sad face appears in the top right
corner of the chart.
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EA's common parameters might be not enabled
The Allow live trading, Allow DLL imports and Allow import of external experts
might be not enabled
• Verify that the Allow live trading, Allow DLL imports and Allow import of
external experts are checked in the EA property dialog (F7).

Autotrading is disabled
The AutoTrading might be disabled
• Verify that the toolbar button AutoTrading is pressed.
Toolbar button when Expert Advisors disabled:

Click to enable:

5.8 EA Is Not Starting Up After Attach to Chart
Issue
The EA reports successful initialisation and advises about disabled Expert Advisors.
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Autotrading is disabled
The AutoTrading might be disabled
• Verify that the toolbar button AutoTrading is pressed.
Toolbar button when Expert Advisors disabled:

Click to enable:

5.9 No Updates to Chart
Issue
The NoWorries EA does not update information on the chart for several minutes.

Connection Lost
MetaTrader should be connected to the broker's server.
1. Check the bottom right corner of MetaTrader, this is when it has lost connection to
the server:

2. If connection is lost then login again or restart MT to force reconnection. Try again
activating the NoWorries EA when connection is back.

Demo account is expired
MT4 will not be able to connect to the demo account if it's expired. In this case MT4 will
keep asking for the login details and fail all login attempt.
• When this happens open a new demo account (right click Accounts in Navigator
window and select Open an Account).
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Market is closed
New tick information and updates to chart happens when markets are open.
• Double check that markets are meant to be open currently.

Disk is full
There should be at least 50MB free disk space available on the drive MetaTrader is
installed on.
• If the free disk space is low then free up space.

5.10 Prompted for Access ID at Service Access Settings
Issue
After attaching to chart the NoWorries EA asks for my Access ID in the Service Access
Settings window.

Type in your Access ID
The NoWorries EA checks that the usage of product is appropriately licensed. After
product purchase a user profile is created on our web support site and the product can be
downloaded from that web site. The support site allows to set up an Access ID which is
required by the NoWorries EA to validate the product licence. By default this Access ID is
configured to be the same as your selected login name to the web support site.
• When prompted, please enter your Access ID to the window and click Save:

Please do not share out to others your Access ID. That is against the licence
agreement terms and conditions and also all 3rd party usages will count when
checking the number of EA copies being used. Sharing out your Access ID can result
in licence check failure and the EA may stop functioning.
Keep your Access ID secure, change it away from the its default value at any time on
the Web Support Centre site.

5.11 Backtest In Visual Mode Not Working
Issue
In the Strategy Tester using the visual mode DLL imports not allowed message
appears on the chart. No result after the Strategy Tester finished its run.
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Global Allow DLL imports is not enabled
You may need to enable the DLL imports in the MT4 for terminal global parameters to run
the NoWorries EA in the backtest environment.
1. Open the MT4 global Options by selecting Tools > Option (CTRL+O)
2. Select the Expert Advisors tab
3. Check the Allow DLL import

5.12 Backtest Not Working
Issue
After the backtest finished no result showing.
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Global Allow DLL imports is not enabled
You may need to enable the DLL imports in the MT4 for terminal global parameters to run
the NoWorries EA in the backtest environment.
1. Open the MT4 global Options by selecting Tools > Option (CTRL+O)
2. Select the Expert Advisors tab
3. Check the Allow DLL import
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Operational Messages
The NoWorries EA operational messages and resolution guide.

Code

Severity

Message

Description

1001

Error

Setup
problem:
DLL
imports not allowed. Tick
Allow DLL imports in
Common
tab
of
the
properties window.

Configuration setting is
missing to allow the EA
to use dynamicaly loaded
libraries (DLLs). Enable the
load of DLLs and restart
the EA. More...

1002

Error

Incomplete EA installation:
Run
setup
application
for
MT4
instance
"<MT4DataPath>'s Data
Folder"

Product installation is not
complete or damaged. Run
the setup application for
the MT4 terminal instance
as displayed. More...

1006

Error

MT4 Expert Advisors are
disabled: click AutoTrading
icon on MT4 toolbar to
execute the EA.

EA does not perform its
operations, not monitoring
nor reacting to price
movements of the market.

More...

1007

Error

Live trading is not allowed
(no smiley face): press F7
and tick Allow live trading
box on Common tab.

The
EA
is
unable
to
perform
trading
operations, there is a sad
icon in the top right corner
of the chart. More...

1008

Error

Authentication failed or
interrupted (<Stopped>,
<Status>, <Response>,
<Reason>,
<FlipOverCount>,
<Latency>)

The EA is not able
to authenticate the user
access to the service at its
start up time. More...

2118

Error

Service access disabled
(<AccessID>,
<ConfirmationID>)
shutting down...

The
user
quits
the
authentication process, or
the EA is not able
to authenticate the user
access to the service.

More...

6.1 Message 1001
Code
1001

Severity
Error

Message

Description

Setup
problem:
DLL
imports not allowed. Tick
Allow DLL imports in
Common
tab
of
the
properties window.

Configuration setting is
missing to allow the EA
to use dynamicaly loaded
libraries (DLLs). Enable the
load of DLLs and restart
the EA. More...
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Setup problem: DLL imports not allowed
Issue
The EA is not able to start up when gets attached to a chart because some of its
dependencies could not be loaded into memory. The EA requires some dynamically loaded
libraries (DLL) to be loaded into memory from disks. When the EA configuration settings
do not allow the load of DLLs then the EA cannot start up and reports this error message.
Possible root cause
• The EA configuration does not allow for the load of DLLs.
Resolution
Enable the load of DLLs in the EA configuration dialog.
1.Attach the EA to a chart, or if already attached then select the chart and
• In case of an EA: press F7
• In case of an indicator: press Ctrl+I and double-click the name of the indicator
in the list.
2.Go to the Common tab of the Property window.
3.Tick the checkbox Allow DLL imports.
4.Click OK.

6.2 Message 1002
Code
1002

Severity
Error

Message

Description

Incomplete EA installation:
Run
setup
application
for
MT4
instance
"<MT4DataPath>'s Data
Folder"

Product installation is not
complete or damaged. Run
the setup application for
the MT4 terminal instance
as displayed. More...

Incomplete Installation
Issue
The EA is not able to start up when gets attached to a chart because some of its
dependencies could not be found on the file system.
Possible root cause
• The EA setup application was not able to perform all its steps, not completed in full.
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• The product was installed manually and some of the steps were missed.
• The MT4 instance's file system got damaged, some files got corrupted or deleted.
Resolution
Download the EA setup application and execute it to get the product installed for the MT4
instance:
1.Download the setup application from Web Support Centre.
2.Execute the setup application to get the product installed. For installation guide refer
to any of the following:
• Getting Started with the NoWorries EA on page 5
• Step-by-step Installation of an Expert4x EA or Indicator

6.3 Message 1006
Code
1006

Severity
Error

Message

Description

MT4 Expert Advisors are
disabled: click AutoTrading
icon on MT4 toolbar to
execute the EA.

EA does not perform its
operations, not monitoring
nor reacting to price
movements of the market.

More...

EA AutoTrading Disabled
Issue
The EA is not responding to price movements, not performing its logic upon data ticks
coming in from the broker. The MT4 toolbar button AutoTrading is disabled.
Possible root cause
• The AutoTrading button on the MT4 toolbar is disabled.

Resolution
Press the AutoTrading button on the MT4 toolbar.

6.4 Message 1007
Code
1007

Severity
Error

Message

Description

Live trading is not allowed
(no smiley face): press F7
and tick Allow live trading
box on Common tab.

The
EA
is
unable
to
perform
trading
operations, there is a sad
icon in the top right corner
of the chart. More...
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Live Trading Not Allowed
Issue
The EA is unable to perform trading operations, there is a sad icon in the top right corner
of the chart.
Possible root cause
• The Allow live trading checkbox is not ticked at the EA properties window.
Resolution
Enable live trading in the EA properties window.
1.Go to the chart and press F7.
2.Go to the Common tab of the Expert properties window.
3.Tick the checkbox Allow live trading.
4.Click OK

6.5 Message 1008
Code
1008

Severity
Error

Message

ToDo

Authentication failed or
interrupted (<Stopped>,
<Status>, <Response>,
<Reason>,
<FlipOverCount>,
<Latency>)

The EA is not able
to authenticate the user
access to the service at its
start up time. More...

Failed Authentication
Issue
The EA is not able to authenticate the user access to the service at attach or restart time
and does not start up.
Possible root cause
•
•
•
•
•

The EA could not connect to the authentication server.
The user quit the authentication process.
There is a typo in the Access ID entered by the user.
The NoWorries EA is not yet purchased by the user.
The NoWorries EA was purchased, but not yet activated by the user.
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• The NoWorries EA was purchased or a trial started, but the licensed period (e.g.
calendar days) has lapsed.
• The NoWorries EA was purchased, but the licensed usage limit (e.g. number of
parallel accesses) is breached by the user.
Resolution
Double check the following items to find resolution to the issue.
1.Ensure that the computer has working Internet connection. For example, go to the
Web Support Centre and see if the page loads with no issues. When the Internet
connection is working, restart the EA by pressing F7 and clicking the OK button of
the Expert property window.
2.Ensure you enter the correct Access ID, case sensitive, without any typo, and click
the Save button of the Service Access Settings authentication window.

3.Ensure you have purchased the product. Log in to the Web Support Centre and select
the NoWorries EA from the product list. If the product is not available for download
then it is yet to be purchased at the Web Support Centre.
4.Count the number of computers you are running the NoWorries EA on. If it is more
than what the purchased EA licence copies allow then either shut down on the excess
number of the computers all the running NoWorries instances, or purchase more
licence at the Web Support Centre.

6.6 Message 2118
Code
2118

Severity
Error

Message

ToDo

Service access disabled
(<AccessID>,
<ConfirmationID>)
shutting down...

The
user
quits
the
authentication process, or
the EA is not able
to authenticate the user
access to the service.

More...

Aborted Authentication
Issue
The EA is not able to authenticate the user access to the service at attach or restart time
and does not start up.
Possible root cause
• The user quit the authentication process.
• The EA could not connect to the authentication server.
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•
•
•
•

There is a typo in the Access ID entered by the user.
The NoWorries EA is not yet purchased by the user.
The NoWorries EA was purchased, but not yet activated by the user.
The NoWorries EA was purchased or a trial started, but the licensed period (e.g.
calendar days) has ellapsed.
• The NoWorries EA was purchased, but the licensed usage limit (e.g. number of
parallel accesses) is breached by the user.
Resolution
Double check the following items to find resolution to the issue.
1.Ensure that the computer has working Internet connection. For example, go to the
Web Support Centre and see if the page loads with no issues. When the Internet
connection is working, restart the EA by pressing F7 and clicking the OK button of
the Expert property window.
2.Ensure you enter the correct Access ID, case sensitive, without any typo, and click
the Save button of the Service Access Settings authentication window.

3.Ensure you have purchased the product. Log in to the Web Support Centre and select
the NoWorries EA from the product list. If the product is not available for download
then it is yet to be purchased at the Web Support Centre.
4.Count the number of computers you are running the NoWorries EA on. If it is more
than what the purchased EA licence copies allow then either shut down on the excess
number of the computers all the running NoWorries instances, or purchase more
licence at the Web Support Centre.
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7

Support
Please contact support@eafactory.com if you require any further assistance. Please copy
info@expert4x.com on your email.
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